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Introduction to Norstar PC Console

1

Norstar PC Console is an application that provides centralized call management and call
activity reporting capability to a business. Norstar PC Console runs on one or more Pentium™
Class personal computers (PCs) under a compatible Windows operating system.
You can customize the way Norstar PC Console is set up to best suit your company’s call management requirements. A telephone attendant uses the graphical user interface to:
•

originate calls

•

answer and manage multiple calls

•

view a company’s name before answering the call

•

record, add and change caller information for future use

•

quickly access information about the caller

•

transfer calls to employees or their voice mail

•

send the caller’s name to the employee’s Norstar telephone display

•

park calls and page employees

•

view information in a Directory about your company’s employees such as their extension
number, person status and telephone status

•

create and print reports showing how incoming calls were handled

•

view the status of all extensions in the company’s Norstar ICS system

About this guide
This document describes how Norstar PC Console works and how to use it in your company.
The instructions in this guide are intended for experienced PC users. The Norstar PC Console
User Guide is organized as follows:
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Introduction to
Norstar PC Console

provides an overview of how this guide is organized,
offers references and discusses using shortcut keys
and right-click mouse capability.

Understanding
Norstar PC Console

explains how Norstar PC Console works and
explains the features available with Norstar PC
Console.

Getting started

describes how to start, minimize, maximize and
close the Norstar PC Console Server and Attendant
programs and how to change the different Attendant
setups.

Working with the Attendant
main window

focuses on the components of the Norstar PC
Console Attendant main window.
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Handling calls

explains how an attendant answers and directs
incoming calls and how a person being called
answers and manages calls.

Maintaining Caller and Employee
information

describes how you enter, edit and maintain caller
and employee information.

Generating reports

focuses on how to use the Norstar PC Console
Reports program to generate and customize various
reports.

Glossary

defines terms and acronyms used in this guide that
are relevant to Norstar PC Console.

Conventions
Naming of window components
Refer to Components of the Attendant main window on page 21 for window terminology used
in this document.

Using the keyboard to navigate around Norstar PC Console
You can use the keyboard to do many tasks quickly in Norstar PC Console. There are three
kinds of keyboard navigation. The first two types are Windows standard while the third type is
particular to Norstar PC Console. They are:
•

Access keys which are the letters underlined in menu names and commands. For more
information, refer to Access keys on page 2.

•

shortcut keys defined on the menus. For more information, refer to Shortcut keys defined
on the menus on page 3.

•

commands initiated by holding down the Alt key plus an additional key. For more information, refer to Commands initiated by holding down the Alt key plus an additional key on
page 3.

Access keys
In Norstar PC Console, each menu name as well as each command within the menus contain
an underlined letter called an Access key.

To use the Access keys:
1. Press and release the Alt key. This gives you access to the menu names in the menu bar.
2. Press the Access key for the menu name and release it. For example, to open the Edit
menu, press Alt then E and the Edit menu will be displayed.
3. Press the Access key for the desired command. For example, to select Caller Information
from the Edit menu, press I and the Edit Caller Information dialog box will be displayed.

Norstar PC Console 1.1 User Guide
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Shortcut keys defined on the menus
Shortcut key combinations are indicated beside some menu commands. In cases where the
Ctrl key is with another key, make sure to hold the Ctrl key down while pressing the second
key in the combination. The additional shortcut keys are as follows.
In the Edit menu:
Cut

Ctrl+X

Copy

Ctrl+C

Paste

Ctrl+V

Dial Paste

Ctrl+D

Transfer Paste

Ctrl+T

In the Transfer menu:
1st Contact

F9

2nd Contact

F10

3rd Contact

F11

Transfer to Target

Num Pad+

Screen Transfer

Ctrl Num Pad+

In the Caller menu:
Answer Next

Esc

Hold

Ctrl+H

Release

F12

Commands initiated by holding down the Alt key plus an additional key
Call handling functions can be accessed directly from the Attendant window using the Alt key
in combination with the underlined keys in the commands. Using this method, the Alt key must
be held down while the other key is being pressed. For example, to place an active call on
Hold, hold down the Alt key and press H.

Processing a call with right-click mouse capability
Right-click mouse capability can help you process calls faster by minimizing mouse
movement. The following call processing options are available with right-mouse capability:

P0887496 01

•

originate a call

•

transfer a call

•

screened transfer
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•

transfer a call to voice mail

•

link transfer

•

park a call and page an employee

•

camp a call on an extension

To use right-click mouse capability:
1. Position the cursor on a name or extension in the Directory group box and right-click the
mouse. A drop-down list of call options appears.

2. Click (left- or right-click) one of the call processing options.

References
As a Norstar PC Console attendant, you may need to refer to the Norstar PC Console
Installation Guide.
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Norstar PC Console is a client/server software application that consists of the following three
interrelated programs operating together under a Windows operating systems:
•

Server program. Refer to Server program on page 5

•

Attendant program. Refer to Attendant program on page 5

•

Reports program. Refer to Reports program on page 6

Server program
The Server program communicates with your Norstar Integrated Communication System (ICS)
initiating Norstar telephone functions such as transferring calls, placing calls on hold and
parking calls.
The Server program talks with one or more Attendant programs. An Attendant program can be
either on the same PC as the one with the Server program or on a separate PC connected via
a Local Area Network (LAN).
The Server program receives:
•

notification of all incoming calls

•

status changes of all telephones attached to the Norstar ICS

The Server program collects and manages call-processing information in a database that can
be used for reporting purposes.

Attendant program
The Attendant program has an easy-to-use graphical user interface. The Attendant main
window displays information about incoming callers and includes a Company Directory with
employee names, telephone status (such as on-hook, off-hook, do not disturb and call
forward) and personal status (None, Not at desk and Out of office). The Directory can be
searched from the Attendant main window.
Attendant PCs can be either main, assistant, overflow or backup. For more information, refer to
Types of attendant setups on page 13 . Incoming calls can be transferred to an extension, a
voice mailbox or to an external number.
Your company can be set up with more than one attendant. Norstar PC Console can also be
set up to provide call coverage for assigned groups of employees. In this setup, you are
notified of calls to assigned employees and can answer calls when those employees cannot.
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Reports program
The Reports program provides information about incoming calls to your company. Reports can
help you identify trends and find answers to questions before they become problems. You can
request a report from any PC with an Attendant program and view the report in the Reports
window or print it on an attached printer.

Norstar PC Console features
There are many features and benefits associated with Norstar PC Console.

Easy to use, time saving Graphical User Interface (GUI)
Norstar PC Console has a GUI that is uncomplicated and uncluttered compared with other
attendant consoles, without sacrificing sophisticated features. It is easy to select the correct
buttons to process incoming calls and very few key strokes are required for most everyday
activities. In fact, answering an incoming call and transferring it to an extension usually
requires only two steps: clicking a Loop button to answer the call and double-clicking the icon
beside the called party’s name to transfer the call.
The GUI provides you with information at-a-glance about the progress and status of calls.
Even before a call is answered, you are provided with advance information about the call and
caller, including the caller’s telephone number and the length of time that the caller has been
waiting. When calls are transferred back to you, the Attendant main window immediately
displays the status of the call.
On-line help is readily available which ensures that Norstar PC Console is easy to learn and to
use.
Because performing normal attendant functions is faster with a GUI, your time is freed up to do
other tasks.

Advanced software capabilities
Here are some of Norstar PC Console’s advanced software capabilities:
Visual call announcing
and control

Even when a telephone is busy with a call, an attendant
can send caller information to the telephone’s two-line
display area. Using display buttons, the person being
called can control the call accordingly. This is a unique
feature because it means that important calls will not be
lost.

Backup attendant

Incoming calls can be quickly and easily transferred to a
backup attendant sitting at a different location than the
main attendant. This means that the backup attendant
does not have to leave his or her own desk to cover for the
main attendant.

Overflow attendant

Overflow calls are transferred to an overflow attendant.
Consequently, calls will not be lost during busy periods.

Norstar PC Console 1.1 User Guide
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Reports

Norstar PC Console provides reports, allowing you to
obtain periodic information such as the number of
incoming calls and who answered the calls. This is important information because it can indicate the calling trends
within the business and the performance of the telephone
system.

Ability to handle growth

A one-time purchase of Norstar PC Console is often all
that is ever needed. If you want to add more attendant
positions as the company grows, Norstar PC Console is
easily expandable.

Attractiveness of PC compatibility
Norstar PC Console has combined telecommunications with personal computing to make the
attendant’s job easier, faster, and more efficient.
Use of existing hardware

There is no need for you to purchase additional dedicated
hardware to obtain the power of Norstar PC Console.
Provided you have the minimum computer requirements,
all that is needed is the software and a simple hardware
enabler allowing your computer to communicate with the
Norstar ICS.

Multi-tasking

Norstar PC Console works in a multi-tasking environment.
You can use your PC for other tasks such as word
processing in addition to attending to calls. You can quickly
switch from PC tasks to the Attendant main window when
there is an incoming call.

Attendant types
Each PC that has the Attendant program installed is set up to handle calls either as a main
attendant, overflow attendant, backup attendant or assistant attendant. Each attendant type
provides flexibility in responding to calls. This ensures that all calls can be handled in a
professional and timely manner. For detailed information about attendant setups, refer to
Types of attendant setups on page 13 .
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Getting started

Once your Norstar PC Console system is set up and checked by the installer or system
administrator, you can use the Norstar PC Console programs. Before you handle calls, you
should know how to start and exit from Norstar PC Console on your PC. For starting the
programs for the first time, refer to Initializing and configuring the Attendant program on page
12.

Starting the Server program
You must start the Server program before the Attendant program.

To start the Server program:
1. On the Windows taskbar, click Start and point to Programs.
2. Point to Norstar PC Console and click Server. The Norstar PC Console Server button,
, is added to the Windows taskbar.
3. Click the Norstar PC Console Server button and the Norstar PC Console Server
window appears. The Server program is ready to use when the Status of Server
Program group box indicates Running.

4. When you have checked that the Server is running, click Minimize,
Server window.

P0887496 01
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Shutting down the Server program
We recommend that you leave the Server program running at all times. In the event you must
shut it down, perform the following steps.

To shutdown the Server program:
1. On the Server PC, click the Norstar PC Console Server button on the taskbar to restore
the Norstar PC Console Server window (if it is not already open).
2. Click File and then click Exit. A dialog box appears asking if you want to close the Server.
3. Click Yes.
The Norstar PC Console Server window closes and the Norstar PC Console Server button,
, no longer appears on the taskbar.
You can also shut down the Server program by right-clicking
Windows taskbar and clicking Close, or clicking the Close box in the title bar.

on the

Starting the Attendant program
Check that the Server program has been started and the Status of Server Program group
box says “Running” before starting the Attendant program. For information about setting the
attributes of the Attendant main window refer to Initializing and configuring the Attendant
program on page 12.

To start the Attendant program and open the Norstar PC Console Attendant main window:
1. On the Attendant PC, click Start on the Windows taskbar and point to Programs.
2. Point to Norstar PC Console and click Attendant. The Norstar PC Console Attendant
button,

, is added to the taskbar.

3. The Norstar PC Console 1.1 introduction window appears briefly, then the Attendant
main window appears. The Tip of the Day window appears.
4. Click Close on the Tip of the Day window.
5. After a few seconds, the Server icon,

, and then the Synchronization icon,

,

appear on the Status Bar.
Note: The Server icon,

and the Synchronization icon,

,

must both be present on the Status Bar before calls can be
processed.

Norstar PC Console 1.1 User Guide
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Minimizing and maximizing the Attendant main window
The Attendant main window can be minimized or maximized depending on your needs.
To minimize the Attendant main window:
1. Click Minimize,

, in the title bar. The Attendant main window minimizes.

To maximize or re-open the Attendant main window:
1. Click the Norstar PC Console Attendant button,
taskbar.

, on the

Shutting down the Attendant program
To shutdown the Attendant program:
1. Click File and then click Exit.
The Attendant main window closes and the Norstar PC Console Attendant button no longer
appears on the taskbar.
You can also shut down the Attendant program by right-clicking the Norstar PC Console
Attendant button on the Windows taskbar and clicking Close, or clicking the Close box in the
title bar.

Checking that the Server and Attendant programs are running
If your PC has both the Server and the Attendant programs installed, be sure both are running
and that they are communicating with each other.
To check that the Server and Attendant programs are running:
1. Check that both
and
appear on
the taskbar. If either does not appear, refer to Starting the Server program on page 9 and
Starting the Attendant program on page 10.
Note: If your PC has only the Attendant program installed, verify that it
is running by checking that
appears on the taskbar.

2. Check that

and

appear in the Status Bar of the Attendant main window.

If you encounter difficulty, refer to the Norstar PC Console Installation Guide or contact your
system administrator.
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Initializing and configuring the Attendant program
Each PC that has the Attendant program installed must be set up to handle calls either as a
full-time main attendant, part-time main attendant, backup attendant, overflow attendant or
assistant attendant.

Starting the Attendant program for the first time
Now that the Server program is set up and operational, the Attendant program can be started
and set up.
To start and set up the Attendant program:
1. On the Windows taskbar, click Start, point to Programs, and then point to Norstar PC
Console.
2. Click Attendant. The Attendant program starts.
3. The first time the Attendant program is started after installation, the Enter Attendant
Options dialog box appears.
4. Enter the extension number for the attendant into the Attendant Extension box.
5. If the network has more than one Norstar PC Console Server running, you will need click
the Server ID box and enter the Server ID for the server you want to use. The Server ID
refers to the Windows TCP/IP host name of the Server PC. For information about how to
determine the Server ID, refer to Determining the TCP/IP host name of a Server PC in the
Norstar PC Console Installation Guide. If there is only one Norstar PC Console Server
running, leave this field blank and the Attendant program automatically connects to that
Server program.
6. Click OK. The Tip of the Day dialog box appears over the Norstar PC Console
Attendant main window.

Norstar PC Console 1.1 User Guide
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7. Click Close. The Norstar PC Console Attendant window main window appears.

8. As soon as the Attendant program begins communicating with the Server program, the
Server icon,

, appears in the Status Bar at the bottom of the Attendant main window.

The Attendant program obtains setup information from the Server program. As this
happens, the individual Norstar telephone extensions appear in the Directory group box
on the Attendant main window. When the setup is complete, the Directory displays all
extensions that are connected to the Norstar ICS and the Synchronization icon,
appears in the Status Bar at the bottom of the Attendant main window.

,

Types of attendant setups
Each PC that has the Attendant program installed must be set up to handle calls either as a
main attendant, overflow attendant, backup attendant or assistant attendant.

Full-time main attendant setup
The full-time main attendant setup is intended for a telephone operator that has the Attendant
main window always visible on their PC. There can be more than one full-time attendant.
Every Attendant program has to have the Server ID and Attendant extension options set
properly for the Attendant program to function. The Server ID indicates to the Attendant
program where the Norstar PC Console Server program is located. The Attendant extension
setting indicates to the Attendant program which Norstar telephone belongs to the attendant.

P0887496 01

Norstar PC Console 1.1 User Guide

14 Getting started

Once the settings are completed, the Attendant program displays all incoming calls to the
attendant’s telephone which appear on the Attendant main window as a yellow Ringing Loop
button. If the attendant’s telephone has been programmed to receive all incoming calls for the
company, that is as a main attendant, then the Norstar PC Console Attendant program now
also displays those calls.
In order to receive and make calls properly, the Attendant program requires that an extension
be associated with the program. The extension must be a valid extension on the Norstar
system and should be the telephone located at the attendant’s desk.

To set or change the attendant’s extension number:
1. Click Tools then Options. The Options dialog box appears with the Options tab displayed.
2. Click the My Extension box in the Attendant group box.
3. Type the extension number of the attendant’s telephone.

Part-time main attendant setup
The part-time main attendant is an attendant that is available to answer incoming calls and
also performs additional functions on the PC, such as word processing.
The difference between the full-time main attendant setup and the part-time main attendant
setup is that the part-time setup has additional Attendant options selected which allow
notification of incoming calls when the attendant program is minimized. Refer to Full-time main
attendant setup on page 13 and Setting up other attendant features on page 17.

Backup attendant setup
A backup attendant is an attendant position that receives calls that have been re-directed from
another attendant position. The backup attendant can, at the same time, be operating as a
main attendant or assistant attendant, or any combination of the attendant types.
Note:

As with all Attendant program setups, the Server ID and
Attendant extension options have to be set within the
Options dialog box. Once this is done, the Attendant program
displays all incoming calls that arrive on the attendant’s
Norstar telephone. Refer to Setting up other attendant
features on page 17.

Each Attendant PC that was set up originally to receive incoming calls must be set up to redirect the calls to the backup Attendant PC.
Note:

Calls can be redirected to another Norstar PC Console
attendant or any Norstar extension within the company.

Norstar PC Console 1.1 User Guide

P0887496 01

Getting started 15

When the attendant needs to leave the position, the backup attendant position can be
activated by using the OUT button,
, on the Attendant main window. This button indicates
that the attendant is no longer present at the station and that all calls should be diverted to the
specified position. After clicking

, the attendant can complete the calls currently in

progress on the Attendant main window. New calls are displayed at the absent attendant’s PC,
but are also presented to the backup attendant’s PC. Even though the attendant is out, the
Attendant program is still able to process calls, if required.

To set up the backup attendant:
1. On the Options tab on the Options dialog box, click the Extension box in the Redirect
calls to group box.
2. Type the backup attendant’s extension number.
3. Select I am Out to control call redirection by

on the toolbar of the Attendant

main window.

Overflow attendant setup
An overflow attendant receives calls that have been redirected from some other attendant
position as a result of more incoming calls than Loop buttons on the other Attendant program.
For example, if a main attendant is already handling six incoming calls, the next call would be
redirected to the overflow attendant until one of the main attendant’s six Loop buttons is free.
The overflow attendant may also be operating as a main attendant, an assistant attendant or
any combination of the attendant types.
Note:

As with all Attendant program setups, the Server ID and
Attendant extension options have to be set within the
Options dialog box. Once this is done, the Attendant program
displays all incoming calls that arrive on the attendant’s
Norstar telephone.

When you set up an Attendant PC as the overflow, each Attendant PC that was originally set
up to receive incoming calls has to be setup to redirect calls to the overflow Attendant PC
whenever overflow conditions exist. At each Attendant PC, the overflow feature needs to be
activated.
Note:

Calls can be redirected to another Norstar PC Console
attendant or any Norstar extension.

When the overflow condition (all Loop buttons in use) occurs on the Attendant position, the
Loop overflow icon,
, in the Attendant Status Bar is turned on and the overflow call is
automatically diverted to the specified extension.
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To define the overflow extension:
1. On the Options tab on the Options dialog box, click the Extension box in the Redirect
calls to group box.
2. Type the overflow attendant’s extension number.
3. Select Call overflow occurs to redirect calls when all of the main attendant’s Loop
buttons are busy with calls.

Assistant attendant setup
An assistant attendant provides call coverage for one or more extensions in the system. This
means that an Attendant program can be set up so that it monitors all incoming calls to
specified extensions. Since the assistant typically uses a PC for other work, Norstar PC
Console provides a way to alert the assistant without requiring the main window to always be
visible on the system. By selecting Assigned extension rings in the Options dialog box, a
Call Notification dialog box pops informing the assistant that an outside call for an Assigned
extension is present.
The Assigned feature is used when an employee would like the assistant attendant, such as
an administrative assistant, to answer the employees’ calls.
Note:

In most cases, calls that have originated from outside the
company, are displayed on the assistant attendant’s main
window. All internal calls from an extension to an assigned
extension functions as usual and are not displayed on the
assistant attendant’s main window.

The Assistant function is enabled by entering extensions into the Assigned box on the
Assigned tab on the Options dialog box.

To add or remove an assistant attendant’s assigned extensions:
1. Click Tools in the Main menu then click Options in the Tools menu.
2. Click the Assigned tab on the Options dialog box.
To add an extension, click the extension you want in the All extensions box then click >>
to copy it to the Assigned extensions box.
To remove an extension from the Assigned extensions box, click the extension number
in the Assigned extensions box and click <<.
The extensions that have been assigned can be viewed at any time by clicking on the
Assigned tab in the Directory group box of the Attendant main window.

Norstar PC Console 1.1 User Guide

P0887496 01

Getting started 17

Setting up other attendant features
Attendant features for the different setups are configured through the Options dialog box. On
the Tools menu, click Options to display this dialog box.

The Options tab is displayed when the Options dialog box first opens. It is divided up into the
following group boxes.
Group box

Description

Pop “Call Notification”
dialog box when

sets the Call Notification dialog box to pop onto the
screen.

Restore minimized
Attendant screen when

sets whether or not the Attendant main window is restored
when a call is answered on your extension.

Redirect calls to

sets the overflow or backup attendant.

Server

displays the name of the server. If there is more than one
server you can manually enter the server name.

Attendant

displays the attendant’s extension. You must manually enter
this during setup

Transfer Options

disables voice mail and link transfer options.

Table 1: Functions of the Options dialog box group boxes
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Notifying the attendant of incoming calls
There are two ways an attendant can be notified of incoming calls:
•

When the attendant is busy working on other activities in Windows, Norstar PC Console is
usually minimized on the Windows taskbar. The attendant can be notified of incoming calls
with a Call Notification dialog box. The attendant can answer the call by clicking Take on
the dialog box or ignore the call, allowing another attendant to answer it.

•

When the main window is visible (not minimized), the Call Notification dialog box does
not appear. The attendant is notified of an incoming call by a Ringing Loop button.

To activate call notification:
1. In the Pop “Call Notification” dialog box when group box, set the options to either one
of the following:
Assigned extension rings - The attendant is notified of calls to the assigned extensions.
or
My extension rings -The attendant is notified when their own extension has an incoming
call.
When both check boxes are clear, the attendant is not notified of calls when the main window is minimized.

Automatic restoring of the Attendant main window when a call comes in
The Attendant main window is normally minimized or under another window in a part-time
attendant environment. The attendant always has the option to restore the screen by clicking
on the Norstar PC Console Attendant button in the Windows taskbar. A quicker method is to
set the Attendant main window to restore automatically.
The Attendant program can automatically restore the main window when the attendant’s
extension goes off-hook (“active”). This assures the attendant has access to the Attendant
main window without having to manually restore it.
To set the Attendant main window to restore automatically:
1. In the Restore minimized Attendant screen when group box, click the Call Answered
on Attendant extension check box.
The main window is restored when the attendant uses the extension to make or answer a
call.

Save the Attendant program options
1. Click OK to save the changes you made on the Options dialog box or click Cancel if you
made no changes or do not want to save the changes. The Attendant options are operational immediately after saving the changes.

Norstar PC Console 1.1 User Guide
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Setting the Attendant Selected option
In addition to the Full tab in the Directory group box of the Attendant main window, there is a
Selected tab that allows the attendant to view a selected subset of the full directory. This is
particularly useful when the attendant’s incoming calls are directed to a limited number of
extensions.

To display selected extensions in the Directory group box of the Attendant main window:
1. Click Tools in the Main menu then click Options.
2. Click the Selected tab on the Options dialog box.
To add an extension, click the extension you want in the All extensions box then click >>
to copy it to the Selected extensions box.
To remove an extension from the Selected extensions box, click the extension number in
the Selected extensions box and click <<.

Setting Transfer options for voice mail and linking
If your Norstar ICS is not connected to a Centrex switch and/or is not connected to Norstar
Voice Mail, then the Link Transfer and/or VM Transfer buttons on the Attendant main window
can be disabled.

To disable the Transfer Options:
1. Click Tools in the Main menu then click Options in the Tools menu. The Transfer
Options group box is located in the bottom right of the dialog.
2. Select the Disable VM Transfer check box to disable the VM Transfer button.
3. Select the Disable Link Transfer check box to disable the Link Transfer button.
Once disabled, the buttons appear grayed out on the Attendant main window. The buttons can
be re-enabled by removing the check mark from the appropriate check box.
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Working with the Attendant main window

4

This section explains how to use the buttons and group boxes on the Norstar PC Console
Attendant main window with the mouse and the keyboard.

Components of the Attendant main window
The Norstar PC Console Attendant main window includes the following:
•

title bar

•

menu bar

•

toolbar

•

Loop buttons

•

Caller Information group box

•

call processing area

•

Directory group box

•

Status Bar

title bar

toolbar
Caller Information group box

menu bar

Call processing area

Directory group box

Loop buttons

Status Bar

Synchronization icon

Server icon

Components of the Attendant main window
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Title bar
The title bar is located at the top of the Attendant main window. The program icon that appears
on the left side of the title bar when clicked contains: Restore, Move, Size, Minimize, Maximize,
and Close. The telephone icon and the program title, Norstar PC Console Attendant is
displayed. On the right side are the Windows standard Minimize, Maximize and Close
buttons.

Menu bar
The menu bar, located just beneath the title bar, displays the menus available including File,
Edit, View, Tools, Transfer, Caller, Target, Attendant and Help. From these menus you can
access many of the functions available in the Attendant program. The menu bar is always
visible on the Attendant main window.

Toolbar
The toolbar, located just beneath the menu bar, contains several buttons that provide quick
and easy access to selected Norstar PC Console functions.

Loop buttons
The Loop buttons are on the left of the Attendant main window labeled F1, F2 and so on, and
are used to answer calls. Each Loop button can handle a single call. The color of a Loop
button and the displayed word indicate the type of call activity occurring. For example, a yellow
Loop button with the displayed word Ringing indicates an incoming call at the attendant’s
extension. You can choose to hide or display all Loop buttons except those that indicate call
activity by selecting and de-selecting Hide Loop Buttons on the View menu. Refer to View
menu on page 25.

Caller Information group box
The Caller Information group box, in the top center of the Attendant main window, displays
information about the caller that is stored in the Norstar PC Console database.

Call processing area
You can make and transfer calls by using the Target box and Call Processing buttons at the
top, far-right of the Attendant main window.
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Directory group box
The Directory group box, located at the bottom of the Attendant main window, consists of
three parts:
Directory list

displays four different tabbed views of extension
information such as name, extension, notes and
department. From here you can select a name and
number to appear in the Target box. The Directory list
also indicates telephone status icon and person status
icon.

Note and Status boxes

allow you to change the status of the employee and write
information in a note for an extension.

Find and Department
boxes and the Show All
and Edit buttons

provide a means of searching for extensions and editing
employee information and extension records.

Status Bar
The Status Bar, located at the bottom of the Attendant main window, toggles between being
displayed and not being displayed.

To display the Status Bar:
1. Click on the View menu.
2. Click on the Status Bar menu item. A checkmark is displayed.
The Status Bar provides the following information:
When the mouse is pointing at a button on the toolbar,
the Status Bar displays a descriptive help message
about the button.
The Synchronization icon is displayed after starting
Norstar PC Console when the Server and the
Attendant databases are communicating with each
other.
The Server icon is displayed when the Attendant
program on your PC is connected to the Server.
The Loop Overflow icon appears when there are
more calls waiting to be answered than there are
Loop buttons available.
The NUM Lock message appears when the Num
Lock key is on.
The current date and time information is always
displayed in the Status Bar.
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Using the menu bar
The menu bar displays the drop-down menus available from the Norstar PC Console
Attendant main window. From these drop-down menus you can access many of the features
available on Norstar PC Console.
The menu bar is always visible on the Attendant main window. Help tips appear in the Status
Bar at the bottom of the Attendant main window when the mouse moves over the commands
in the drop-down menu.

File menu

The File menu command is:
Exit

closes the Attendant program.

Edit menu

The Edit menu commands include:
Cut

cuts selected text from an editable box and moves it to the
Clipboard.

Copy

copies a selection of text from an editable box and moves it
to the Clipboard.

Paste

inserts the Clipboard contents at the insertion point.

Dial Paste

dials the number in the Clipboard. The number can include
special characters such as hyphen, parenthesis, space or
period.
Note:
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The Clipboard contents are appended to any
characters already in the Target box. This allows
you to type a routing code in the Target box first
and then click Dial Paste.
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Transfer Paste

transfers a call to the number in the Clipboard.

Caller Information...

opens the Edit Caller Information dialog box. The Edit
button in the Caller Information group box performs the
same function. Refer to The Edit Caller Information dialog
box on page 33 and Maintaining caller information on page
57.

Employee Information...

opens the Edit Employee Information dialog box. The Edit
button in the Directory group box performs the same
function.Refer to The Edit Employee Information dialog box.
on page 37 and Maintaining employee information on page
61.

View menu

The View menu commands are:
Toolbar

shows/hides the toolbar.

Status Bar

shows/hides the Status Bar.

Hide Loop Buttons

shows/hides the inactive Loop buttons. When checked, only
active Loop buttons appear on the Attendant main window.

Tools menu

The Tools menu commands are:
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Reports

starts the Reports program.

Attendant Monitor

opens the Attendant Monitor dialog box that displays
diagnostic information sent by the Attendant program and
received back from the Server program. The Attendant
Monitor helps in troubleshooting.

Log to File

writes Attendant program activity and Server messaging to a
log file. This is used for troubleshooting.
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Options…

opens the Options dialog box which has three tabs.
The Options tab:
allows you to assign the Server ID, enter the Attendant
extension, select the conditions for making the Norstar PC
Console Attendant main window appear, and select the
conditions for call redirection.
The Assigned tab:
allows you to choose extensions to appear in the Assigned
tab contained in the Directory group box on the Attendant
main window.
The Selected tab:
allows you to choose extensions to appear in the Selected
tab contained in the Directory group box of the Attendant
main window.
For more information, refer to Using the Directory group box
on page 35.

Transfer menu

The Transfer menu commands are:
1st Contact

transfers the active call to the caller’s first contact. This
command is enabled when there is an active call and a
contact is displayed in the first box of the Contacts group
box.

2nd Contact

transfers the active call to the caller’s second contact. This
command is enabled when there is an active call and a
contact is displayed in the second box of the Contacts group
box.

3rd Contact

transfers the active call to the caller’s third contact. This
command is enabled when there is an active call and a
contact is displayed in the third box of the Contacts group
box.
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Transfer to Target

transfers the active call to the extension in the Target box.
The Transfer button performs the same function.

Screen Transfer

screens a call transfer of an active call to the extension
number in the Target box. The caller is automatically put onhold when the Screen Transfer menu option is clicked and
then connected when you click Transfer Now in the Screen
Transfer dialog box. The Screen button performs the same
function. Refer to Parking, holding and screening calls on
page 47.

Transfer to VMail

transfers the active call to the voice mailbox of the extension
in the Target box. The VMTransfer button performs the
same function.

Caller menu

The Caller menu commands are:
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Answer Next

answers the next call in the queue.

Hold

places an active call on hold. The Hold button performs the
same function. Refer to Parking, holding and screening calls
on page 47.

Release

disconnects the active call. The Release button performs
the same function.

Park

places the active call in park so that you can page the
person whose extension is in the Target box. A list of all
calls parked by all attendant consoles is displayed in the
Parked Calls dialog box when you click on View Parked
Calls on the Caller menu. The call can be retrieved from the
View Parked Calls dialog box by pressing Retrieve. For
more information on viewing parked calls, refer to Parking,
holding and screening calls on page 47. The Park/Page
button performs the same function.
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Join Caller

connects two callers by joining the active call with the call
that is on hold. Refer to Linking and Joining calls on page
50.

View Parked Calls...

opens the Parked Calls dialog box which displays all calls
parked by all attendants. A call can be retrieved by any
Norstar PC Console attendant or from any telephone in the
Norstar ICS. For more information, refer to Parking, holding
and screening calls on page 47.

Target menu

The Target menu commands are:
Call

initiates a call from the attendant extension to the number in
the Target box. The Call button performs the same function.

Voice call

places a voice call from the Attendant to the extension in the
Target box. For more information, refer to Contacting
employees using Voice Call on page 50.

Dial DTMF Tones

dials DTMF-tone digits to the external number in the Target
box. This must be used in conjunction with the Link button
and with outdialing on an active line to access other systems
or carriers (for example, Centrex).

Link

accesses (hookflash) Centrex/CO line features (such as offpremise transfer or conference) or other systems or carriers
while on an incoming call. Clicking on the Link button while
on an incoming call places the caller on hold and generates
a Link signal (also called flash or recall) on the active line.
The DTMF button is used in conjunction with the Link button
to outdial the digits in the Target box. For more information,
refer to Linking and Joining calls on page 50.
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Attendant menu

The Attendant menu commands are:
In

acts as a toggle switch with the Out command. When
checked, the attendant is in position to take calls.

Out

acts as a toggle switch with the In command. When
checked, the attendant is not in position to take calls. All
calls that ring at the attendant’s telephone are forwarded to
the backup attendant position.
Note:

Redirection of calls to a backup extension must
be set in the Options dialog box which is
accessed from the Tools menu.

Help menu

The Help menu options include:
Tip of the Day

shows/hides the Tip of the Day window when Norstar PC
Console starts.

Norstar PC Console Help

displays Help files.

About Attendant

displays program information, revision number, copyright
information, and system information.

Using the toolbar
The toolbar contains several buttons that provide quick and easy access to some of the
Norstar PC Console functions.

To display the toolbar:
1. Click on the View menu.
2. Click on the Toolbar command. The toolbar is displayed across the top of the Attendant
main window below the menu bar.
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The toolbar contains the following:.

The IN and OUT buttons are used to indicate whether or not
you are able to take calls.
Note:

Redirection of calls to a backup extension must
be set in the Options dialog box which is
accessed from the Tools menu.

The Link button is used to access Centrex/CO line features
(such as off-premise transfer or conference) or other
systems or carriers while on an outside call. For more
information, refer to Linking and Joining calls on page 50
The DTMF button is used to dial DTMF-tone digits to the
external number in the Target box. This must be used in
conjunction with the Link button and with outdialing on an
active line to access other systems or carriers such as
Centrex. This button is also used to send special characters
(for example, *, #) from the Target box to other services
such as Interactive Voice Response (IVR) and Norstar voice
messaging services.

The Join button connects two callers by joining the active
call with the call that is on hold at the Norstar PC Console.
Refer to Linking and Joining calls on page 50.

Clicking the View Parked button displays the Parked dialog
box which contains a list of parked calls. Calls can be parked
and retrieved from any Norstar telephone connected to your
Norstar ICS. Refer to Parking calls and paging employees
on page 47.
The Voice Call button initiates a call from the attendant’s
telephone to the speaker of another telephone without first
causing the telephone to ring. Refer to Parking calls and
paging employees on page 47.
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A total of six Loop buttons, labeled F1 to F6, are located on
the left side of the Attendant main window and are used to
answer a call. Each Loop button represents a potential call
in-progress. The color of a Loop button and the displayed
word indicate the type of call activity occurring.
Loop buttons can be hidden or displayed, depending on your
preference. Click View and then Hide Loop Buttons. When
a checkmark is displayed, only active Loop buttons are
displayed and unused Loop buttons are hidden. When Hide
Loop Buttons is not checked, all Loop buttons appear on
the Attendant main window whether or not they are active.
Words and colors on Loop buttons
The word Ringing appears on a yellow
Loop button when an incoming call is
currently ringing at the attendant’s
extension.
A green Loop button with the word
Active appears when a call is
answered by the attendant. Only one
Loop button is active at one time.
A blue Loop button with the words On
Hold appears when a call is on hold at
the attendant’s extension.
An orange Loop button with the word
Callback appears when a call has
returned to the attendant from the
Target extension.
A red Loop button with the word
Ringing appears when a call is ringing
an Assigned extension.
Grey Loop buttons appears when the
Loop button is inactive and when Hide
Loop Buttons is not selected from the
View menu.
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Using the Caller Information group box
The Caller Information group box is located in the top, center of the Attendant main window.
It contains information about the caller that is automatically filled into the boxes by Norstar PC
Console when a call is answered.

The Caller Information group box includes:
•

Name, Caller Type (Unclassified, Personal, Employee, Vendor, or Customer), Company
and Note box

•

Contacts group box which displays the three parties the caller most frequently calls in
your company

The following buttons appear in the Caller Information group box:

opens the Edit Caller Information dialog box. Refer to
Maintaining caller information on page 57.

places the active call on Hold.

disconnects the active call.

places the active call in park and opens the Page dialog box
so that you can page the person whose extension is in the
Target box. Refer to Parking calls and paging employees
on page 47.
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The Edit Caller Information dialog box
This dialog box is displayed when you click the Edit button in the Caller Information group
box. This is where information about callers is changed or added.

The Edit Caller Information dialog box contains the following boxes. Most are editable unless
otherwise indicated.
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•

Name box contains the caller’s name. A first time caller name would be the Caller ID name
provided by the telephone company. You can change this Caller ID name to the actual
caller’s name.

•

Caller Type box contains the classification of the caller. There are five types to choose
from: Unclassified, Personal, Employee, Vendor and Customer.

•

Company box contains the name of the company associated with the caller. The Caller ID
name is automatically filled in this box. It can be edited here or in the Caller Information
group box.

•

Phone box contains the telephone number of the caller.

•

City, State/Province, and ZIP/Postal Code boxes are related to the caller.

•

Caller ID Name and Caller ID Number boxes contain information provided through subscription by the public switched telephone network.

•

Record Number box contains a unique caller record identifier number. This box is not
editable.

•

Contacts boxes list the caller’s three most frequently called persons in your company.
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The following buttons appear in the Edit Caller Information dialog box:

saves the caller record displayed in the boxes of the Edit
Caller Information dialog box to the database.
closes the Edit Caller Information dialog box without
saving the changes to the record.
opens the Find dialog box in the Edit Caller Information
dialog box.

creates a blank caller record which you can fill in.

creates a new name caller record using an existing caller
record. All boxes except the Name box are filled in with the
existing caller information. You can then enter the new
name.
deletes caller record displayed in the Edit Caller
Information dialog box from the database.

Using the call processing area

The call processing area is found at the top right of the Attendant main window and includes:
•

the Target box

•

a series of buttons including: Transfer, Page, VMTransfer, Screen, Call, Camp On and
Link Transfer.
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The Target box is used to enter the extension or telephone
number to be called.

The following buttons appear in the call processing area:

transfers the active call to the extension number in the
Target box.
screens a call transfer of an active call to the extension
number in the Target box. Click Screen and the caller is
automatically put on hold. The caller is connected to the
Target extension when you click Transfer Now in the
Screen Transfer dialog box.

opens the Page dialog box.

makes a call from the attendant’s extension to the number in
the Target box.

transfers the active call to the voice mailbox of the extension
in the Target box so the caller can leave a message.

places a call on hold at the target extension.
accesses Centrex/CO line features (such as off-premise
transfer or conference) or other systems or carriers while on
an outside call. It is also used to tone dial the digits in the
Target box.

Using the Directory group box
The Directory group box is located at the bottom of the Attendant main window. It contains
tabbed directories showing various views of the extensions on your Norstar telephone system.
The Directory group box also contains buttons and boxes for searching and editing extension
and employee information.
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Search and edit functions in the Directory group box
The buttons and boxes in the Directory group box are used to search for and edit employee
information that appears in the Directory list. They are listed below.
indicates the person status of the employee.
When an option is selected from the dropdown list box, a corresponding icon appears in
the first column of the Directory list. The
available options are: None, Not at Desk,
and Out of Office,

.

used to enter information about individual
employees.
changes the caller/Caller ID record to an
employee record when an employee calls in
from outside. This prevents an employee name
from appearing in the caller record related to
the Caller ID name/number.
is used to search for names of individual
employees or groups of employees by
department. The top box is used to search for
employee by name and the bottom box is used
to search by department. Enter the first few
letters of a name in the top box then click Find.
All of the names that start with those letters
are displayed in the Directory list. To search
by department, choose a department from the
Department box drop-down list, then click
Find. All of the employees in the selected
department are displayed in the Directory list.
resets the Full tab Directory view to display all
names and extensions.
opens the Edit Employee Information dialog
box. If you have a name/extension highlighted
in the Directory list, information pertaining to
that name/extension appears in the dialog box.
If you have not selected a name/extension,
then the Edit Employee Information dialog
box is blank. You can also access the Edit
Employee Information window by clicking the
Edit menu then clicking Employee
Information. Refer to The Edit Employee
Information dialog box. on page 37and
Maintaining employee information on page 61.
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The Edit Employee Information dialog box.
This dialog box appears when you click the Edit button in the Directory group box. This is
where information about employees can be changed or added. For further information, refer to
Maintaining employee information on page 61.

The Edit Employee Information dialog box contains the following boxes which are editable
unless indicated otherwise:
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•

Name box contains the employee’s name or the extension number if a name has not been
entered.

•

Type box contains the classification of the employee record. “Employee” is the default.

•

Department box contains the name of the department associated with the employee.

•

Phone box contains the telephone number of the employee. The Phone box is not editable.

•

City box displays the city of the employee.

•

State/Province box displays the state or province of the employee.

•

ZIP/Postal Code box displays the ZIP code or Postal Code of the employee.

•

Assistant Extension box displays the extension of the person who handles calls for the
extension when the employee cannot.

•

Record Number box displays a unique record identifier number. The Record Number
box is not editable.

•

Voice Mail DN box displays the voice mailbox extension of the employee. The Voice Mail
DN box is not editable.

•

Contacts box lists the employee’s three most frequently called persons/extensions in the
Company.
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The following buttons appear in the Edit Employee Information dialog box:

saves the employee information displayed to the database.

closes the window without saving the record.

opens the Find dialog box in the Edit Employee
Information dialog box. Refer to Maintaining employee
information on page 61
creates a new name for the extension and leaves all other
boxes unchanged.

Directory list
Directory list tab views
There are four Directory list views that are accessed by clicking on tabs. They are:

Note: The Synchronization icon,
, must appear on the Status
Bar for the information in the Directory list to be complete.
Full
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displays all extensions that are connected to the Norstar
ICS. This includes wireless Companion telephones, Norstar
Voice Mail extensions and Hunt group extensions. This view
displays the maximum amount of extension and employee
information allowed in the Directory list.
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BLF

also displays all extensions that are connected to the
Norstar ICS. As in Full tab view, the BLF (Busy Lamp Field)
tab view includes wireless Companion telephones, Norstar
Voice Mail extensions and Hunt group extensions. This view,
however, only displays the person status icon, telephone
status icon and employee name. This allows more
extensions to be displayed at once.

Assigned

displays specific extensions for which an assistant attendant
is responsible. Like the Full tab view, the Assigned tab view
displays the maximum amount of extension and employee
information allowed in the Directory list. Extensions are
assigned or removed from the Assigned tab view in the
Options dialog box. Refer to Assistant attendant setup on
page 16.

Selected

displays a subset of the Full tab extensions. Like the Full
tab view, the Selected tab view displays the maximum
amount of extension and employee information allowed in
the Directory list. Selected extensions are particularly
useful when the attendant directs incoming calls to a limited
number of extensions and wants to display only those
extensions. Extensions are added or removed from the
Selected tab in the Options dialog box.

Directory list employee and extension information
Each one of the Directory list tab views contains the following types of employee and
extension information.
Note:
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The first two columns are not labeled and contain icons only,
no text.

person status icon

This is the left most column in the Directory list views and
does not have a column heading. It may contain an icon or
be blank. The person status icon provides an indication of
the physical location of the employee. Refer to Search and
edit functions in the Directory group box on page 36.

telephone status icon

This is the second column from the left in the Directory list
views and does not have a column heading. The telephone
icons show the current status of the telephones connected
to your Norstar ICS. They also show additional information
such as whether the extension is ready to receive calls or
has been placed on Do Not Disturb (DND). The telephone
icons are:
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Available
for calls

Do Not
Disturb

Call
Forwarded

On-hook
Off-hook

Note: A Hunt Group is a group of telephones that can be all
called by a single number. Hunt Groups are
configured in your Norstar ICS. The telephone status
icon for a Hunt Group extension is blue and always
indicates on-hook.
The remainder of the columns in the Directory list are labeled as follows:
Name

is the first labeled column on the left and contains the names
of employees.

Ext

contains telephone extensions.

Notes

displays additional information about the employee that the
attendant has entered. The Notes can only be edited from
the Notes box found at the top of the Directory group box.

Department

displays the name of the department to which the
corresponding employee belongs. The department is
entered by clicking on the Edit button and using the Edit
Employee Information dialog box. Refer to Maintaining
employee information on page 61.

Sorting information in the Directory list tabs
Extension and employee information contained in the Directory list tabs can be sorted in
different ways. In the Full, Assigned and Selected views, the information is contained in
columns with headings.

To sort alphabetically by Name, Notes or Department:
1. In the Directory list box, click either on the Name, Notes or Department column heading.
The information is sorted alphabetically using the column you selected.

To sort numerically by extension:
1. In the Directory list box, click on the Ext column heading. The information is sorted
numerically by extension.
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Handling calls

With Norstar PC Console, you can manage calls using either your PC’s mouse or the
keyboard. When a call comes in, you can respond to the caller either by using the telephone or
a headset.
Note:

It is recommended that you use a headset so that your hands
are free to enter information on your PC.

The basic steps in processing an incoming call with Norstar PC Console include:
answering a call. Refer to Answering calls as an attendant on page 41.
•

finding the called person’s extension and placing it in the Target box. Refer to Finding the
called person’s extension and placing it in the Target box on page 43.

•

transferring a call. Refer to Transferring a call on page 45.

Other telephone functions include:
•

parking the incoming call and paging the employee. Refer to Parking, holding and screening calls on page 47.

•

linking and joining calls. Refer to Linking and Joining calls on page 50.

•

handling a callback call. Refer to Handling a callback call on page 51.

•

making a call from the attendant’s extension. Refer to Making a call from the attendant’s
extension on page 53.

•

managing calls at the employee’s telephone. Refer to Managing calls at the employee’s
telephone on page 54.

The following steps explain how you handle calls as an attendant using the Attendant main
window. For further information about and a diagram of the Attendant main window, refer to
Components of the Attendant main window on page 21.

Answering calls as an attendant
The Attendant main window has six Loop buttons that are used to answer calls.
Each Loop button can handle a single call in-progress. The color of the Loop button changes
based on the activity occurring. You can show or hide inactive Loop buttons by clicking Hide
Loop Buttons on the View menu. If hidden, the Loop buttons only appear when a call occurs.
A Loop Overflow icon,

, on the Status Bar shows that calls are incoming beyond the sixth

Loop button.
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A new incoming call is indicated by a yellow Loop button that displays the word Ringing.
Information about the call appears around the Loop button to assist you in personalized call
processing:
•

A function key name, located above the Loop button, (F1 in the example) designates the
function key on the PC keyboard that relates to the ringing Loop button.

•

A timer, found above the Loop button, indicates in minutes and seconds how long the call
has been active.

•

A company name, displayed on the top line of the information to the right of the Loop button, shows the identity of the company that is calling. The company name is either from
the caller database or, if the caller is new, from the Caller ID name provided by the telephone company. If you do not subscribe to Caller ID service, then this line of display will be
blank. A company name can be entered or edited using the Caller Information group box.

•

The Caller ID name, displayed on the second line of the information to the right of the
Loop button, shows the Caller ID number provided by the telephone company. If you do
not subscribe to Caller ID service, then this line of display will be blank.

•

The bottom line of information to the right of the Loop button displays the name of the
Norstar ICS line that carried the call.
Note:

Norstar ICS line names are programmed in your Norstar ICS
by your telephone administrator.

Note:

If your Norstar ICS is shared by two or more companies, the
telephone administrator can associate the names of each
company with their particular hardware lines. This means that
you can tell which company is being called, even before
answering the call.

To answer an incoming call:
1. A Loop button turns yellow and the label changes to Ringing. You can respond to a call
one of four ways:
•

Click the yellow Ringing Loop button.

•

Press the function key on the PC keyboard (for example, F1) shown above the Loop
button.

•

Press the Esc key.

•

Press the associated intercom or line key on your telephone.

The Loop button becomes green and displays the word Active.

Norstar PC Console 1.1 User Guide

P0887496 01

Handling calls 43

2. Answer the call with your company greeting and determine from the caller to whom they
wish to speak. If you are answering a call from this number and/or company for the first
time, you can enter caller information. For further information, refer to The Edit Caller
Information dialog box on page 33. If you are not, refer to Finding the called person’s
extension and placing it in the Target box on page 43.

To release or hang up a call:

1. Click

. This disconnects the active call and the Loop button becomes idle.

Finding the called person’s extension
and placing it in the Target box
Once a call is answered, the next step is to find and click on the called extension, placing it in
the Target box.
There are four ways to locate the correct extension when you are ready to process a call,
including:
•

Using the Contacts group box on page 43

•

Using the Directory tab views on page 44

•

Using the Directory Find box on page 44

•

Using the Department box on page 45

Using the Contacts group box
The Contacts group box is pre-loaded with extension numbers and names of the three most
frequently called parties that the caller requests. These caller contacts are listed from most
frequently to least frequently called.

To the left of each Contact box is the current person status icon for that contact, and to the
right of each Contact box is that person’s telephone status icon.

To transfer a caller to one of the three most frequently called parties:
1. Double-click the telephone status icon.
The call is forwarded to that extension.
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Using the Directory tab views
The tab view area in the Directory group box contains various views of extensions.

To search by Extension or Name:
1. Click the Full, BLF, Assigned or Selected tab.
2. Click the extension, the name or the department of the employee being called in the list.
The name and/or extension number now appears in the Target box.
3. Click Transfer.

Using the Directory Find box
Use the Directory Find box to search by name.

To search by Name and place the target extension in the Target box:
1. Position the cursor in the Find box.
2. Type the first letter or letters of the person’s last name or first name, depending on how the
employee names were entered. For example, if they were entered “Jane Doe”, type “j”. If
they were entered “Doe, Jane”, type “d”.
3. Click Find. All matching names are displayed in a list under the Full tab.
4. In the Directory list box, click the name of the employee being called. The name now
appears in the Target box.
5. To restore all names in the Full tab view, click Show All.
After the search result is shown in the Full tab view, the BLF, Selected and Assigned tab
views remain unchanged.
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Using the Department box
You can search for a name by department on the Full tab using the Department box.

To search by department:
1. Click the down arrow of the Department box. A list of departments that are associated
with extensions appears in the drop down list.
Note:

Department names for each extension are created in the Edit
Employee Information dialog box.

2. Click a department name from the drop-down list and the department name appears in the
Department box.
3. Click Find. All extensions matching the department are displayed in a list under the Full
Directory tab view.
4. In the Directory list box, click the name of the employee being called. The name appears
in the Target box.
5. After the search result is shown in the Full tab view, the BLF, Selected and Assigned tab
views remain unchanged. To restore all names in the Full tab view, click the Show All
button.

Transferring a call
An active call can be transferred to an extension using the Contacts box, the Target box or
the Directory group box. A call can also be transferred to voice mail.

To transfer using the Contacts box:
1. Double-click the telephone status icon to the right of the Contacts box.The call is then
transferred to the displayed extension.
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To transfer using the Target box:

1. Make sure the extension in the Target box is correct. Double-click the telephone status
icon to the right of the Target box or click Transfer. You can also use the keyboard by
positioning the cursor in the Target box and pressing Enter. The call is then transferred to
the displayed extension.

To transfer using the Directory group box list:

1. Scroll through the Directory list. Double-click the telephone status icon or the name of the
person to whom you are transferring the call. The call is transferred.

To transfer a call to the voice mailbox of the extension in the Target box:
1. Place the extension number of the employee in the Target box.
. When the caller is transferred the Loop button becomes idle.

2. Click
Note:

The VMTransfer button can be made inactive when a nonNorstar voice messaging system is attached to the Norstar
ICS.

To transfer a call to an outside number:
1. With an active incoming call on Norstar PC Console, position the cursor in the Target box.
2. Type an outside telephone number.
3. Click
box is tone dialed.

. The Loop button label shows Active, and the number in the Target

4. Click Release and the incoming call is transferred to the outside telephone number.
The Attendant is disconnected from the call and the Loop button becomes idle.
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Parking, holding and screening calls
Norstar PC Console provides you with the capability to screen calls for the called person, to
place the calls on hold and to park calls so that the called person can be paged. You can also
talk to the employee in intercom mode using Voice Call.

Parking calls and paging employees
The Park/Page feature allows you to place a call on Hold and page the employee. You can also
use this method to page an employee when there is no active call

To park a call and page an employee:
1. Place the extension number of the called person in the Target box. If there is no active call
and you just want to page an employee, type or place the extension of the person being
paged in the Target box.
2. Click
. The Page dialog box opens. The Page dialog box shows all parked
calls and all page zones so that the called person can be paged.
.

3. Click on a call in the Parked calls box and then click on the appropriate zone in the Page
zones box.
4. Click Page. The Console Message box appears and a low-level audible tone is emitted by
the speakers on the telephones in the selected zone.
5. Speak into the headset or handset (depending on your setup). When finished, click OK.
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To retrieve a parked call:
1. On the Caller menu, click View Parked Calls.
2. Select the parked call in the Parked Calls dialog box.
3. Click Retrieve.

OR
1. On the toolbar, click

.

2. Select the parked call in the Parked Calls dialog box.
3. Click Retrieve.

To view all parked calls that are still in park:
1. On the Caller menu, click View Parked Calls. A Parked Calls dialog box appears and
lists all parked calls with the following information:
•

the park number of the call

•

the caller’s name (from the Name box of the Caller Information group box)

•

the name or extension of the called employee

2. Click Close. The Parked Calls dialog box closes.

Placing and retrieving calls on hold
Calls can be easily placed on Hold and retrieved quickly.

To put an incoming call on hold:
1. Click the Ringing Loop button.
2. Click
or click another Ringing Loop button. This automatically puts the
previous call on hold.
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3. When the active call is placed on hold, the Loop button label changes to Hold and the
Loop button color changes to blue.

To place a call on Hold at an active extension:
1. With an active call on the Loop button and the employee’s extension in the Target box,
click
. When the active call is camped on the Target box extension (placed on
hold at the Target extension), the Loop button becomes idle.
2. The camped call sends a message with tones to the employee either on or off the
telephone, indicating a call is camped on their extension.

To retrieve a call on Hold:
1. Click the blue Loop button labeled On Hold. The Caller Information boxes show all of
the information related to this call.
2. Respond to the call accordingly.

Screening calls
You can screen calls by talking with the employee first and asking whether they want to talk to
the caller.
To screen/transfer a call:

1. Click
. The active call goes on hold. The Loop button changes color to blue.
The extension rings and a Screened Transfer dialog box appears.

2. Ask the person being called if they can take the call. If the answer is yes, click
and the call is transferred. If the answer is no, perform the following steps.
3. Click Cancel.
4. Click the Loop button on which the call is being held to reconnect with the caller.
5. Process the call accordingly.
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Contacting employees using Voice Call
This feature can be used as an intercom to talk directly through the speaker of the employee’s
telephone.
To use the Voice Call button:
1. Position the cursor in the Target box and type or enter the extension of the employee.
2. On the toolbar, click

.

3. You may now speak to the employee through the speaker in their telephone.

Linking and Joining calls
Using Norstar PC Console, you can link calls to create conference calls or have callers join
existing calls to also create conference calls.

To use the DTMF button with an active incoming call on a Loop button:
Note: The DTMF button is used when transferring or linking calls on
Centrex lines.
1. Click

on the toolbar. The active incoming call is placed on hold.

2. Position the cursor in the Target box and type an outside telephone number.
3. Click
on the toolbar. The number in the Target box is dialed out with DTMF tones on
the same CO line on which the active incoming call arrived.
4. Click Release and the incoming call is transferred to the outside telephone number (using
the telephone company’s Centrex capability). The Attendant is disconnected from the call
and the Loop button becomes idle.

To Join a call on hold on a Loop button with an active call on another Loop button:
1. Click

on the toolbar.

2. Drag the “Join” cursor to the Loop button on which the call is being held.
3. Click the Loop button holding the call. The two callers are now connected, the Attendant is
released from the active call and both Loop buttons become idle.

To create a conference call to an outside number:
1. With an active incoming call on Norstar PC Console, position the cursor in the Target box.
2. Type an outside telephone number.
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. The Loop button label shows Active, and the number in the Target

3. Click
box is tone dialed.

4. Click the Link button to set up a conference call between the incoming call, the outgoing
call and the Attendant.
When the conference call is finished, click Release to disconnect from the call.
Note:

To disable the Link Transfer button, open the Options dialog
box on the Tools menu and select the Disable Link Transfer
Option button.

Handling a callback call
There are two types of calls that return to Norstar PC Console:
•

a call that was not answered at the extension to which it was transferred

•

a call that the called person returned to you for attendant handling

Responding to a callback that an extension did not answer
A callback may be a call that was sent to an extension, not answered and returned to you.

The callback is indicated by

.

The Loop button displays attendant messaging including the name and extension from which
the call has returned and other call related information. This allows you to personalize the
handling of the call.

To respond to a Callback call:

1. Click

.

The Caller Information group box shows the information originally displayed so that you can
process the call accordingly, such as transfer to Norstar voice messaging, park the call, page
the called person, and so on.
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Responding to a callback that a called party returned
A call that the called person elects not to take can be handled by you according to instructions
that you or your company have established. This type of call is similar to a Callback to the
attendant. The called person, can use the buttons below the display area of the telephone,
communicate to you, the attendant, how the call should be handled with one of the following
pre-set messages:
•

Hold. You ask the caller to hold for a moment.

•

Assist. You send the caller to the called party’s assistant.

•

IntAct. You inform the caller that the person they called is currently on the line and ask if
they wish to interrupt the call.

The display button pressed by the employee sends a pre-set message to you. Either Hold,
Assistant or Interact is displayed below the orange Callback Loop button.

To respond to a Callback call that a called party returned:

1. Click
displayed.

. The Caller Information group box shows the information originally

2. Advise the caller according to the pre-set message that appears.

To process a hold call:
1. Advise the caller that the employee would like them to hold.
2. Enter the employee’s extension in the Target box.
3. Click

. The call is now camped onto the called employee’s extension.

To process an assistant call:
1. Advise the caller that the employee is temporarily unable to take calls and has requested
that calls be routed to the Assistant extension.
2. Enter the assistant’s extension number in the Target box. The number is located in the
Assistant Extension box on the Edit Employee Information dialog box.
3. Transfer the call to the assistant’s extension number.

To process an interact call:
1. Advise the caller that the employee is on another call but can be interrupted.
2. If the caller agrees, enter the employee’s extension in the Target box.
3. Transfer the call back to the extension.
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Making a call from the attendant’s extension
As the attendant, you can call any extension within the company as well as any outside
number. The telephone number you type in the Target box does not require special characters
such as a hyphen, a parenthesis, a blank space or a comma (special characters are ignored).
However, to reach special services such as Interactive Voice Response systems (IVR) you
may type special characters (*, #, P, and W) in the Target box and these characters can be
dialed using

on the toolbar.

To place a call to an extension/outside number:
1. When there is no active call, place an extension or outside number in the Target box.
2. Press Enter on the keyboard. A call is made to the extension/outside number.

To transfer a call to an extension:
1. Place an extension in the Target box when there is an active call.
2. Press Enter on the keyboard. The call is transferred to the extension.

Selecting an entry in the Directory or in the Contacts box also enters the extension number
into the Target box. When the Target is an extension, the Person Status icon for that person
appears to the left of the Target box, and to the right of the Target is that person’s telephone
status icon.

To make a call to an inside extension:
1. Make sure that the number you want to call is displayed in the Target box. You can type
the extension in directly or select it from the Directory list. For further information, refer to
Using the Directory Find box on page 44.
2. Click

or press Enter to make the call.

To make a call to an outside number:
1. Place the cursor in the Target box and type the same digits you would dial if you were
using your Norstar telephone.
2. Click
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Managing calls at the employee’s telephone
Norstar PC Console has features which allow the employees to also manage their calls from
their telephones.
Once a call has been routed to an extension, a low-level audible tone alerts the called person
they have an incoming call, even if they are on their telephone. The name of the caller appears
in the display area of the called party’s telephone for a few seconds.
The called person has six options for managing the call using the three display buttons below
the display area of the Norstar telephone. These include:
•

talking to the caller

•

placing the call on hold

•

sending the call to Norstar voice messaging

•

joining the call with the current call

•

sending the call back to the attendant to ask the caller if they wish to interrupt the current
call

•

sending the call back to the attendant to be routed to an assistant attendant
Note: Press the Next display button to see more than the first two
options that appear.

To talk to the caller:
1. Press the Talk display button to automatically connect with the call or pick up the
telephone.
If the telephone is in use, pressing the Talk display button automatically puts the first call on
hold and the new caller is connected.

To send the caller to the attendant who asks the caller to hold:
1. Press the Holddisplay button on the telephone. This delivers a pre-set message to the
attendant. The attendant asks the caller to hold for the called person and camps the call
onto the called person’s extension.
2. The called person sees the call camped onto their telephone and handles the call.

To send the caller to Norstar voice messaging:
1. Press the VM display button on the telephone.
The call is automatically transferred to the called person’s voice mailbox.

To join the caller with another call:
1. Press the Join display button to conference the caller in with your current call.
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By looking at the caller’s name or Caller ID name in the display area of the Norstar telephone,
the called person decides to join the caller with the current call.

To send the call to the attendant who asks the caller if they want to interrupt:
1. Press the IntAct display button. This delivers a pre-set message to the attendant who
asks the caller if they want to interrupt the employee.
2. If yes, the attendant transfers the call back to the employee.
3. The calling party name appears in the Norstar telephone display area of the called
person’s telephone for approximately 20 seconds. To pick up the call that the attendant
transfers back, press the Talk display button.

To send the caller to an Assistant extension:
1. Press the Assist display button. This delivers a pre-set message to the attendant. The
attendant tells the caller that the called person is temporarily unable to take calls and has
requested that they be routed to an Assistant extension.
2. The attendant refers to the Assistant extension box in the Edit Employee Information
dialog box and enters the Assistant extension number in the Target box.
3. The attendant transfers the call to the Assistant extension.

P0887496 01

Norstar PC Console 1.1 User Guide

56 Handling calls

Norstar PC Console 1.1 User Guide

P0887496 01

Maintaining caller and employee information

6

Norstar PC Console manages both caller and employee information.

Maintaining caller information
When your company is called, information about the caller available from the Norstar PC
Console database appears in the Caller Information group box of the Attendant main
window. Whether or not you enter information for an incoming call depends on whether the
caller is calling for the first time or has called previously and has information already entered in
the database.

Creating a new caller record
New caller records are created in the following ways:
•

automatically, during an active call, the first time Caller ID information is received by the
Attendant program. You can customize the new caller record during the active call or later.
Note:

The caller record is not saved if you click Release without
processing the call.

•

when you create a new caller record from an existing one

•

when you create a new blank caller record

When a call comes in, Norstar PC Console checks the Caller ID provided by the telephone
company to see if the number has previously called. If there is a record that the number has
called before, information available from the caller database is displayed in the Caller
Information group box on the Attendant main window. The Name box drop down list displays
the names of callers on record that are associated with the incoming Caller ID. There may be
several callers from the same telephone number calling if they are employees at the same
company. For more information, refer to The Edit Caller Information dialog box on page 33.
When you select the name of the caller from the list, the Caller Information group box is
populated with information about the caller.

To create a new caller record from an active call:
1. Click on the Ringing Loop button to answer the incoming call. Some information may or
may not appear in the Caller Information group box on the Attendant main window.
2. Click Edit in the Caller Information group box. The Edit Caller Information dialog box
appears.
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3. Click
. This clears all boxes in the Edit Caller Information dialog box and
allows you to create a new caller record.
4. In the Name box, type the caller’s name in the format last name first, space, then first
name.
5. In the Caller Type box, click the down arrow then click a Caller Type, either Unclassified,
Personal, Employee, Vendor or Customer.
6. In the Company box, type the caller’s company’s name.
7. Click Save and the information can be recalled at a later date. If you click Close without
saving, you are prompted with the message, “Do you want to save the current record?”.
Click Yes to save the record.
8. After you enter caller information, process the call by:
•

transferring the call to the called party. Refer to Transferring a call on page 45.

•

placing the call on hold. Refer to Parking, holding and screening calls on page 47.

•

transferring the call to Norstar voice messaging. Refer to Transferring a call on page
45.

•

parking the call and paging the called party. Refer to Parking calls and paging employees on page 47.

To create a new name caller record from an existing caller record:
1. Click Edit in the Caller Information group box on the Attendant main window. The Edit
Caller Information dialog box appears.
2. Click
. This clears only the Name box in the Edit Caller Information dialog
box and leaves all other boxes unchanged.
3. Place the cursor in the Name box and type the new caller’s name.
4. Click Save when done to save the record.
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To create a new caller record when there are no active calls:
1. Click Edit in the Caller Information group box. The Edit Caller Information dialog box
appears.
2. Press New Caller. A new blank caller record is created with a new Record Number
assigned.
3. Fill in the boxes with the desired information.
4. Press Save to save the new caller record.

To create a new caller record associated with an existing Caller ID when there are no active
calls:
1. Click Edit in the Caller Information group box. The Edit Caller Information dialog box
appears.
2. Click Find, and type the name of another caller from the same company and click OK.

3. Click New Name and the Name box becomes blank (all other boxes remain unaltered).
4. Type the new caller’s name.
5. Click Save. The record is now saved in the database.
6. Click Close.

To save caller information:
1. Click
. The changes made to the boxes in the Edit Caller Information dialog box are saved to the database. After clicking Save, the Edit Caller Information dialog
box remains open.

To close the Edit Caller Information dialog box:

1. Click
Note:

P0887496 01

. The Edit Caller Information dialog box closes.
If you click Close without first clicking Save, the Edit Caller
Information dialog box closes without saving any changes.
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Finding and editing caller information
Caller information can be edited at any time and the changes can be saved.

To find caller information:
1. Click Edit in the Caller Information group box on the Attendant main window. The Edit
Caller Information dialog box appears.
. The Find dialog box appears.

2. Click

The Find dialog box is used to find a caller’s name in the database. When the Find dialog
box opens, the cursor is in the Name box.
3. In the Name box, type the first letter or letters of the caller’s last name.
Note:

If the caller’s first name is used instead of their last name,
type the first letter or letters of the caller’s first name.

4. Click OK or press Enter. The Find dialog box closes.
5. All matching names are displayed in the Name box of the Edit Caller Information dialog
box. If there is more than one name, a drop down list appears below the Name box.

6. Click on the caller name you want to edit. The information associated with that caller fills in
the Edit Caller Information dialog box.

To edit a caller’s record:
1. Make sure the caller name you want to edit is displayed in the Edit Caller Information
dialog box. Position the cursor in the box you want to edit and make the change. Repeat if
needed.
2. Click Save to save the changes to the database.
3. Click Close to close the Edit Caller Information dialog box.
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Note:

If you answer a call and then open the Edit Caller
Information dialog box without first selecting a name from
the Name box list, you must click Edit twice.

To delete an existing caller record:
1. Click Edit in the Caller Information group box on the Attendant main window. The Edit
Caller Information dialog box appears.
2. Make sure the caller name you want to delete is displayed.
3. Click
. The record displayed in the Edit Caller Information dialog box is
deleted from the database.

Maintaining employee information
When Norstar PC Console is installed, employee information is extracted by the Server. This
information is automatically displayed in the Directory list box in the bottom center of the
Attendant main window.
The Directory list box has four different tabs that display lists of employees. They are Full,
BLF (Busy Lamp Field), Assigned and Selected. For further information, refer to Search
and edit functions in the Directory group box on page 36.

Working with the Directory list
Information in the Directory list appears in ascending order (for example, 1 to 9 or A to Z), and
sorting is based on the contents of only one column at a time. When there are different forms
of information in the same columns, priority is given in the following order: no information
entered (blank), numeric then alphabetic. For example, when you sort a Name column that
contains both names and extension numbers, the extension numbers appear before the
names.

You can sort Directory information by column in any of the tabbed views by clicking any
column heading. For example, to sort the directory by extension, click on the Ext column
heading. The listing appears with the extensions in numerical order.
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To sort a column of information in the Directory:
1. Click the tab for the view you want to sort, either Full, Selected or Assigned. Information
in the BLF tab view appears in the same order you selected for Full view.
2. Using the mouse, position the cursor and click the column heading you want to sort, either
Name, Ext, Notes or Department.

Finding an employee record
You can search for an employee by name, by department or by an individual within a
department.
You can search by an employee’s name two different ways:
•

by clicking Edit and then Find on the Edit Employee Information dialog box

•

by clicking Find in the Directory group box on the Attendant main window

To search by name clicking Edit in the Edit Employee Information dialog box:
1. Click Edit in the Directory group box on the Attendant main window. The Edit Employee
Information dialog box appears. For more information, refer to The Edit Employee Information dialog box. on page 37.

2. Click
. The Find dialog box appears.The Find dialog box is used to find an
employee’s name in the database. When the Find dialog box opens, the cursor is in the
Name box.
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3. In the Name box, type the first letter or letters of the employee’s last name.
Note:

If the employee’s first name is used instead of their last name,
type the first letter or letters of the employee’s first name.

4. Click OK or press Enter. The Find dialog box closes. All matching names are displayed in
the Name box of the Edit Employee Information dialog box. If there is more than one
name, a drop down list appears below the Name box.

To search by name on any Directory group box on the Attendant main window:
1. Position the cursor in the Find box on the Attendant main window.

2. Type the first letter(s) of the person’s surname or given name according to how names are
listed in the Name column under Directory.
3. Click
. All names matching the letter(s) you entered are displayed in a list under
the Full tab Directory view.
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To search by department:
Note: A department search takes priority over a name search.
1. Click the down arrow of the Department box in the Directory group box. A list of departments that are associated with extensions appear in the drop down list. The name of the
department for each extension is created in the Edit Employee Information dialog box.

2. Click the department name from the drop down list and the department name appears in
the Department box.
3. Click
. All extensions matching the department are displayed in a list under the
Full tab Directory view.

To search for an individual within a department:
1. Select the department in the Department box.
2. Type the name in the Find box.
3. Click
. All extensions matching the name within the department are shown in a
list under the Full tab Directory view.

Resetting the Full tab view
The Full tab view can be reset to the default display.

To reset the Full tab view:
1. Click

in the Directory group area.

Regardless of the Directory view, the Full tab view appears with all extension, names, notes
and department information. Use this button to restore the Directory view after you perform a
search.

Editing employee information
Employee information can be easily edited by adding or changing an extension, changing the
person status of an extension or by creating a new name for an extension.
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To add or change an extension:
1. In any Directory tab view (Full, BLF, Selected or Assigned), click the extension in the
Directory list about which you wish to change or add information.
2. Click
in the Directory group box. The Edit Employee Information dialog box
opens. It allows you to create or edit information in the employee database.
3. Position the cursor in any editable box and type in the new information.
4. Click Save to save the changes to the database and to automatically apply the changes to
the employee’s extension in the Directory.
5. Click Close to close the Edit Employee Information window.

To change the Person status of an extension:
1. In any of the Directory views (Full, BLF, Assigned or Selected), click the extension.
2. Click the drop down arrow of the Status box (found in the Directory group box).

3. Click the status from the drop down list, either None, Not at desk or Out of office. The
status you chose now appears as an icon in the Directory view to the far left of the
extension Name.
There is no icon for None. Instead, a blank space appears next to the person’s telephone
status if this is selected.
or
appear when Out of office or Not at desk
(respectively) are selected from the list.
Note: Do not type in the Status box.

Creating a new name for an extension
You can change the name of an employee assigned to an extension.

To create a new name for an extension:
1. In the Directory group box, click Edit. The Edit Employee Information dialog box
appears.
2. Click
. The cursor is positioned in the Name box and the Name box is ready
for editing. All other boxes in the Edit Employee Information dialog box are unchanged.
3. Type in the new employee’s name.
4. Click Save when done.
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Using the Make Caller button
This function is used when an employee calls from a customer’s office.

To assign the name of an employee to a caller record:
1. Select the employee's extension in the Directory (or enter the employee’s extension number in the Target box)
2. Click

.

The name of the employee is now assigned to the caller record and is not saved as a customer
record.

Adding notes to employee records
You can select from a list of notes or type a personal note for an extension to appear in the
Notes column under Directory in the Attendant main window.
Note:

You cannot change an extension’s note unless the Attendant
and Server databases are synchronized and, the
Synchronization icon,

, appears on the Status Bar.

To select from the available list of notes:
1. Click an extension number in the Full, Assigned or Selected Directory views.
2. Click the drop down arrow of the Note box.

3. Click the applicable note from the drop down list. The note now appears in the Notes
column under Directory.

To type a note:
1. Click an extension number in the Full, Assigned or Selected Directory views.
2. Position the cursor in the Note box, and type a note.
3. Press Enter. The note now appears in the Notes column under Directory.
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Note:

For a blank Note box, delete what is in the Note box then
press Enter.

To save employee edit changes:

1. Click
in the Edit Employee Information dialog box. The changes made to
the boxes in the Edit Employee Information dialog box for the employee highlighted in
the Directory list is saved to the database. After clicking Save, the Edit Employee Information dialog box remains open.

To close the Edit Employee Information dialog box without saving changes:

1. Click
Note:
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. The Edit Employee Information dialog box closes.
If you click Close without first clicking Save, the Edit
Employee Information dialog box closes without saving any
changes.
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Norstar PC Console automatically collects information about incoming calls and tracks how
calls are processed. This important information is available through Reports to help spot
trends and provide answers to questions before they become problems.
Reports provide caller related information that can help to:
•

increase sales opportunities

•

improve productivity

•

lower expenses

•

streamline operations

For example, the report Calls by Customer shows how callers from your company’s top
customers are being handled. It addresses the question of whether calls are being taken by
employees or being routed to Norstar voice messaging.

Report types
There are three report types:
•

Calls by Customers

•

Calls to Employees

•

Extension Directory

Calls by Customers report
This report shows how calls from your customers are handled by your employees. Each
employee report can identify as many customers as necessary. Calls are distributed by
destination which shows the number of calls taken by the employee, routed to Norstar voice
messaging or handled by others. Of total calls from each customer, the percentage of calls by
destination is also indicated allowing review of call taking effectiveness.
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Calls to Employees report
The Calls to Employee report shows the type of calls employees are receiving over a defined
time period. This report can spot caller abuse such as too many personal calls and
misdirected calls, such as calls from customers routed to the wrong person/department. This
report displays the type of caller across the top and employee(s) down the left side. Each
Caller Type has a column for number of calls and percent. Total of all calls and percent is
shown separately.
.

Extension Directory report
Extension Directory shows a listing of all employees that are in the Norstar PC Console
database along with the information in their call record.
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Working with the Reports window
You can get to the Norstar PC Console Reports window by clicking on Tools on the Attendant
main menu and then choosing Reports. The Reports window consists of Database,
Information, Period and Employees group boxes and a report viewing area. The menu bar
across the top of the Reports window includes standard File, Edit, View and Help menus.
With the Create Report, Page <, Page > and Print buttons you can define the type of report
you want to create. You can manipulate the preview image once a report is created.

Database group box

This group box contains information on selecting a database.

Clicking Select accesses the Open dialog box from which
you can select a Microsoft Access database. For more
information about databases and how to locate the database
(.mdb) file, refer to Selecting the database on page 74.
You can type the path-name of a Microsoft Access database
in the Current Database edit box.

Information group box

The Information group box contains the report type information.

The Report Type is active and available when a
valid Microsoft Access database is set in the
Current Database edit box.
When a report type is selected, a description of
that report type appears in the Description area.
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Period group box

Note:

The Period group box is active provided a valid database is
selected and a Report Type is selected that requires a Report
Period to be defined.
opens the One Week dialog box from which you can specify
a report period with a duration of one week (Sunday through
Saturday).
opens the One Month dialog box. This dialog box is
intended to allow easy selection of a Report Period
consisting of an entire month.
shows the date of the beginning of the report period. The
date edit boxes change to reflect dates set by other controls
such as the Month, Week, and Calendar buttons. The
dates in the edit boxes are checked to maintain the general
rule that the From date must come earlier than or be the
same as the To date. If this rule is broken, an error message
is displayed.
opens up Calendar dialog boxes for use in quickly setting
the From and To Report Period Dates. The Calendar dialog
box is designed to resemble the Calendar dialogs used in
other applications for Windows operating systems. The
Calendar buttons are active provided a valid database is
selected and a Report Type is selected that requires a
Report Period to be defined.

Norstar PC Console 1.1 User Guide

P0887496 01

Generating reports 73

Employees and

customers group boxes

You can use these boxes to choose customers or employees for which a report is to be
generated.

All and Select option buttons

The Customer and Employees group areas contain:

used to generate a report that includes data for all members of
the selected category (Employees or Customers).

used to generate a report that includes data for only those
members listed in the list box. If you click Select, the button
beneath the selection list box (labeled either Customer or
Employee) becomes available so you can make your selection.
Note: The All and Select buttons for Employees or Customers is
only available if a valid database is selected, the report period
is set, and a Report Type was chosen which utilizes the
category (Employees or Customers).
list box

only displays information if you have chosen to select a subset of
the customers and employees in your database. If you choose
All, the list box remains blank. The list box cannot be directly
edited. If the selected list is long enough, it can be scrolled to
view its contents. Changing the contents of the list is done with
the button below the list box.

Customer/Employee
button

access directories. The Employee and Customer buttons are
only active when you choose Select. Clicking on these buttons
display either the Employee or Customer Record Selection
dialog box from which you can make your selection.
Note: These buttons are available only if a valid Database has
been chosen, a Report Period has been given (if
required), a Report Type which involves either Employees
or Customers has been selected, and the Select option
button for the category has been chosen.
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Customers and Employees Selection dialog box
The Customer and Employee Selection dialog boxes are where you can choose which
Employees or Customers to include in a report.

The program records which items were selected in this dialog the last time you created a
report. When the dialog opens, any items which were selected last time appears as selected.
In this way, the list of selected items can be modified.

Creating and viewing reports
The Reports program is designed to make it easy to generate quality reports for analyzing
telephone usage at your organization. The following section provides the steps required to
generate reports, including:
•

selecting the Database

•

selecting a report type

•

setting the report period

•

selecting employees and customers

•

creating and previewing the report

•

printing the report

Selecting the database
Norstar PC Console stores information about telephone usage in your organization in a
special database. This database is used to generate the different types of reports. In most
cases, you will want to use the database that was installed with the Norstar ICS system.
However, if you make backups of the database for archiving purposes, Reports can use those
backups as well. If you are generating reports from a PC that does not have the database
stored, locate the database on the server PC through Network Neighborhood. Check with the
system administrator to ensure that the database is a shared file.
There are two methods of selecting a Microsoft Access database for reports from the Reports
window:
•

using Select in the Database group box

•

using the Current Database box
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To point to a database using Select:
1. Click Select. The Open dialog box appears.
2. Click the Look in box.
3. In the drop-down list, locate and click Hard drive (C:), then click Program Files.
4. Double-click the following folders: Nortel, Norstar PC Console, Server, and
ConsoleServerDB.
5. Click the filename ConsoleServer.mdb.

6. Click Open to connect to the selected file name. If this file is not a valid database, an error
message appears.

To point to a database using the Current Database box:
1. Enter the path name of the database in the Current Database box: C:\Program
Files\Nortel\Norstar PC Console\Server\ConsoleServerDB\ConsoleServer.mdb.

2. Press Enter. If this file is not a valid database, an error message appears.

Selecting a report type
Once a database has been selected, the next step is to decide what type of report to produce.

To select a report type:
1. Click the Report Type drop-down list box.
2. Select your report.
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Setting the report period
Some reports require a report period. The report period defines the time span for which data is
considered. If the report type chosen does not require a report period, the Period group box is
inactive. The report period begins on the From date and ends on and includes the To date.

To enter the From and To dates:
1. Click on the From box and enter the date. The following are acceptable date formats.
•

June 5, 1997

•

6/5/1997

2. Press Enter.
3. Repeat for the To box. Press Enter.
Note: If a date is typed in an unrecognized format, or if a typed date
does not exist, an error message is displayed.

To cancel out of the From/To boxes:
1. Press Tab or Esc.

To specify a report of one week:
1. Click on

. The One Week dialog box appears. Choose the month that the

desired week started or ended in from the month drop-down list.
2. Select the year the week occurred in the year box. You can either type in the year box or
use the increment and decrement arrows to the right of the year box.
3. Select a week from the list of weeks in the box at the bottom of the dialog. Either click on a
week and click OK or double-click the desired week. When a week is selected, the start
and end dates of the week appears in the From and To date edit boxes.

To specify a report of one month:

1. Click

. The One Month dialog box appears. Choose the desired month from

the month drop-down list.
2. Set the desired year, using the year control, either by typing it in or adjusting its value with
the increment and decrement arrows to its right.
3. When done, click OK to accept the month, or Cancel the Report Period selection.
If a month was selected, the starting and ending dates of the month appears in the From and
To date edit boxes, respectively. Dates for February automatically account for leap-years,
centuries, and millennia.
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To cancel a selection you made, press the Esc key or click Cancel. The Period group box
information is not changed.

Clearing a date
A date can be cleared by deleting the contents of the edit box. A cleared edit box does not
count as a date, and thus does not restrict the range of the other date by the above mentionedrule.
Note: The To and From date edit boxes are active provided a valid
database is selected and a Report Type is selected that
requires a Report Period to be defined.

Selecting employees and customers for the report
Some report types, especially those dealing with call data, allow you to choose sets of
employees, customers, or both, for which the data are summarized in the report. Reports
make only those categories available which are appropriate to the report type you chose. If
your Report Type does not need or allow these selections, the Employees and Customers
selection areas remain inactive and you can move on to the next step.

To select the Employees or Customers:
1. Click on either Employees or Customers. This displays the Employee or Customer
Record Selection dialog box.
Note: The first time you click one of these buttons after connecting
to a database, a wait cursor appears while Reports builds the
directory. Afterward, and whenever the button is clicked, a
pause follows while Reports creates and fills the dialog box.
This pause is to be expected, especially for large directories.
After the pause, the Selection dialog box appears.
2. The Selection dialog box consists of a list of Employees or Customers. For Customers,
the list consists of a single column, the Customer’s Company Name. For Employees, it
consists of several columns, such as last, first and middle names, and telephone
extension. These columns can be resized by dragging the column header edges in the bar
at the top of the list.
3. You can choose either a single item or multiple items. Selected items appear with a blue
background running behind their boxes. Choose a single item by pointing and clicking on
it. Choose multiple items by holding down the Control key while selecting the items you
want. Up to 100 items can be selected from the list. If you require more than 100 items,
consider doing several reports with different selection lists, or using the All button.
4. Click OK. The Customer or Employee Record Selection dialog box closes and the
related Selection list box displays only those items selected from the dialog.
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Create Report button
When all the data needed to create a report has been provided in the other report controls,
becomes available.

To create a report:

1. Click

. This starts the report generation process.

2. The Reporting Animation icon, just to the left of the button, begins moving, indicating that
the report is running. The animation continues until the report is completed.
Note: While it is running, the application cannot be closed. If you
need to close the application while a report is running, this
can be done from the Close Programs dialog box available
from the Windows Task Manager. Refer to Windows Help for
information about how to force programs to close.
3. Once the report is completed, it is displayed in the Report Viewing area below the Report
controls.
becomes unavailable again, indicating that the report has been
created.The Report controls are disabled and the keyboard functions only in the Report
Viewing area. You can re-access the Report controls by pressing the Tab key.

Viewing the report you generated
Once a report has been created, the Page buttons,
The Next Page button

and

, become available.

shows the next available page of the report, if there is one, in

the report view. The Previous Page button

, shows the previous page of the report, if

there is one.
The page number of the current page appears in the report itself, found in the lower right hand
corner of each page.
You can also change the displayed report page from the keyboard.

To change the viewed page from the keyboard:
1. The keyboard should be active in the Report Display area which is the lower half of the
Norstar PC Console Reports window. This is set automatically after creating report, but
can also be done by pressing Tab to cycle through the Report controls. The Report Viewing area is treated as the last control in the Tab order sequence.
2. Press Ctrl + Page Up to view the previous page, or Ctrl + Page Down to view the next
page.
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Printing a report
Once a report has been created and is in the Report Viewing area,
available.

becomes

To print a report:

1. Click
. This prints the report to the default printer.The default printer can be
changed from the Printers folder. It can be reached from either the Windows Start Menu or
the Windows Control Panel. Refer to PC Console Help.
2. A dialog opens allowing you to choose the pages and number of copies of the report to
print.
3. Click OK and the report begins printing. Clicking Cancel cancels it.
Note: If a Report Parameter is changed in one of the Report
Controls,

again becomes active and

becomes inactive. Do not change any Report
Parameters before printing the report. If you do, you have to
generate the report over again and then print it.
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Assistant attendant
The assistant attendant is the telephone attendant who provides call coverage for specific
employee(s).
Backup attendant
The Backup attendant receives calls when the main attendant is not available. The main
attendant uses the Out button on the Attendant main window to direct calls to the backup
attendant.
BLF
This is one of the Directory list tab views. It displays only the phone status and extensions of
the employees.
CF
Call Forward
Caller ID
Caller ID is also known as CLID or Calling Line Identification and is provided by your telephone
company. When Caller ID is in place, the caller name and number are displayed on incoming
calls.
CO
Central Office
CTA - Computer Telephony Adapter
A CTA is the hardware device used to connect a PC to the Norstar ICS, and includes the CTA
100, an external device, and the CTA 150i which is installed in a PC hard drive.
Destination extension
The destination extension is the person’s extension to which a caller (or attendant) is
attempting to connect.
DND
Do not disturb
DTMF - Dual Tone Multi Frequency
DTMF is the sound emitted when telephone buttons are pressed.
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External call
External call is a call originating from outside your company’s voice mail system.
ICS - Norstar Integrated Communications System
ICS is the Norstar key system that Norstar PC Console is connected to. Two types of Norstar
ICS are Modular ICS (MICS) and Compact ICS (CICS).
ID
Identification
Internal call
An internal call is a call that originates from your company’s Norstar ICS, such as another
employee’s extension.
Hookflash
This is the signal that occurs when a telephone goes on-hook followed by off-hook.
Hunt Group
A Hunt Group is a group of telephones that can be all called by a single number. Hunt Groups
are configured in your Norstar ICS.
LAN
Local area network
Main attendant
A main attendant is the telephone attendant primarily responsible for managing a company’s
incoming calls that may or may not have other attendants to assist.
Networked model
Networked model is a way of setting up a Norstar PC Console system in which the main
attendant’s PC is connected to one or more additional attendant PC(s) through a network.
Norstar PC Console
Norstar PC Console is a Windows based software product that provides call management and
call activity reporting capability to a business.
Norstar ICS
Norstar Integrated Communication System. The telephone system that Norstar PC Console
works with. The two types of Norstar ICS systems are the Modular ICS and the Compact ICS.
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Overflow attendant
The overflow attendant receives incoming calls when there are more than six active calls at the
main attendant’s PC.
PC
Personal Computer
Server program
The Norstar PC Console Server program supports the Attendant program residing in the PC.
Shared system
A shared system is a Norstar PC Console system in which the Norstar ICS is shared by two or
more companies.
Stand-alone model
A stand-alone model is a Norstar PC Console system in which one attendant only manages a
business’s incoming calls. There are no assistant attendants, backup attendants or overflow
attendants in a stand-alone model.
Target extension
A target extension is the extension number to which you are directing a call.
VM
Voice mail or voice messaging.
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Calendar button72
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screening49
transferring45
Call answered on Attendant extension18
Call Forwarded40
Call Notification dialog box16, 17, 18
Call overflow occurs16
Call processing area22
Call button35
Camp On button35
Link Transfer button35
Page button35
Screen button35
Transfer button35
using34
VMTransfer button35
Callback31
Caller Information25
Caller information
finding and editing60
maintaining57
Caller Information group box22
using32
Caller information group box
Edit button32
Hold button32
Park/Page button32
Release button32
Caller menu27
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deleting61
Caller Type33
Calls by customers report69
Calls to employees report70
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Close button38
Company box33
Computer Telephony Adapter81
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Configuring
Attendant program12
ConsoleServer.mdb75
Contacting employees using Voice Call50
Contacts box33, 37
Contacts group box43
Conventions2
Copy24
Creating a new caller record57
CTA81
Cut24

D
Department box37, 45
Dial DTMF Tones28
Dial Paste24
Directory Find box44
Directory group box13, 16, 18, 23
Directory list23, 38, 61
Department column40
employee information39
Ext column40
extension information39
Name column40
Notes column40
sorting information40
Directory list tab views38, 39, 44
BLF tab view39
Full38
Selected39
Disable Link Transfer19
Disable VM Transfer19
Do Not Disturb40
DTMF button30

Edit Employee Information dialog box62
Assistant Extension box37
Contacts box37
Department box37
Voice Mail DN box37
Edit menu24
Editing employee information64
Employee information
editing64
maintaining57
Employee Information...25
Employee record
finding62
Employee records
adding notes to66
Exit24
Extension
creating an new name for65
finding the correct43
Extension box15
Extension Directory report70
Extension, Attendant12

F
File menu24
Find button38
Finding an employee record62
Finding and editing caller information60
Finding the correct extension43
Full tab
Directory group box18
Full tab view38
resetting64
Full-time main attendant13

E

G

Edit Caller Information dialog box33, 59
Caller ID Name33
Caller ID Number33
Caller Type33
Close button34
Company box33
Contacts33
Delete Caller button34
Find button34
Name box37
New Caller button34
New Name button34
Phone box33
Record number33
Save button34
Edit Employee Information37
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Getting9
Getting started9
Glossary81
Green Loop button31
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N

Handling a Callback call
Callback call51
Handling calls41
Help file29
Help menu29
Hide Loop Buttons25
Hold27, 48
placing and retrieving calls48
Hold button32
Hunt Group40

Name box33, 37, 60
Networked model82
New Caller button59
New Name button38
Norstar Integrated Communication System82
Norstar PC Console
About1
Attendant button18
Introduction1
keyboard navigation2
uses1
Norstar PC Console Attendant window13
Norstar PC Console features6
Norstar PC Console Help29
Norstar PC Console Installation Guide4
Note23

I
I am Out15
ICS82
In29
In and Out buttons30
Initializing
Attendant program12
Introduction to Norstar PC Console1

J
Join button30

L
LAN82
Link28
Link button30
Link Transfer button19
Linking and Joining calls50
Log to File25
Loop button14, 15, 18, 31, 42
words and colors31
Loop buttons22
Loop Overflow icon23, 41
Loop overflow icon15

M
Main attendant, full-time13
Main window21
Maintaining Caller and Employee Information57
Maintaining caller information57
Maintaining employee information61
Making a call from the attendant’s extension53
Managing calls at the employee’s telephone54
Managing calls using telephone display buttons54
Menu bar22
using24
Menus available from the main window22
My Extension14
My extension rings18
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Off-hook40
One Month button72
One Week button72
On-hook40
Options dialog box12, 14, 17, 18
Assigned tab16
Selected tab19
Options…26
Orange Loop button31
Out29
OUT button15
Overflow attendant6, 15

P
Page button35
Park27, 28
Park/Page button32
Parked calls box47
Parking calls and paging employees47
Parking, Holding and Screening calls47
Part-time main attendant14
Paste24
Period group box72
Person status icon39
Phone box33, 37
Placing and retrieving calls on Hold48
Pop Call Notification dialog box when17
Postal Code of the employee37
Processing a call with right-click mouse capability3
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R
Record Number box37
Red Loop button31
Redirect calls to15, 16, 17
Release27
Release button32
Reports7, 25
All button73
calls by customers69
calls to employees70
Customer/Employee button73
Database group box71
extension directory70
generating69
Information group box71
Select button73
setting the current database75
types69
working with71
Reports program6
Reports window71
Resetting the Full tab view64
Restore minimized Attendant screen when17, 18
Restoring Attendant main window18
Right-click mouse capability3
Ringing31
Ringing Assigned Extension31

S
Save button38
Screen Transfer27
Screening calls49
Search by department64
Search for an individual64
Select button73
Selected extensions box19
Selected tab
Directory group box18
Options dialog box19
Selected tab view39
Server17
Server icon13, 23
Server program5
checking its running11
shutting down10
Shared system83
Shutting down the Attendant program11
Shutting down the Server program10
Stand-alone model83
Starting the Attendant program10
State/Province box37
Status Bar23, 25
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T
Take button18
Target box35
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VM54
Telephone status icon39
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call forward40
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off-hook40
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Tip of the Day29
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U
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V
View menu25
View Parked button30
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W
Windows operating system5
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Z
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